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This year more than ever, 
attendees at STC’s 51st Annual Conference in 
Baltimore are likely to be attending a session 
that includes one or more expert guest 
speakers from the Orlando chapter. While 
some chapters typically don’t have attendees 
at the Conference, Orlando will be represented 
by a contingent of 17 members, 8 of whom 
will be presenting to the international audience 
of technical communicators, with a dozen 
taking part in Leadership Day sessions. These 
numbers are an all-time high for our chapter. 
 
ORLANDO PRESENTERS 
Orlando presenters in Baltimore include Alicia 
Fellure, Christina Hammock, Dan Jones, 
Karen Lane, Mike Murray, Bonnie Spivey, 
Dan Voss, and W.C. Wiese. Cindy Hauptner 
and Bob Stultz will also be published in the 
conference Proceedings, but Dan Jones will 
be presenting on their behalf since they cannot 
attend. 
 
ORLANDO PRESENTATIONS IN DATE AND 
TIME SEQUENCE 
Sunday, 10:30-11:45 a.m. (Room: TBD) 

Title: “Innovative Chapter Development 
Ideas” (LS 2) 
Format: Panel Discussion 
Topic: Jaffe Award Presentation 
Presenters: Alicia Fellure, Mike Murray, 
and W.C. Wiese 
 
Topic: Turnkey Packages on Mentoring, 
Fund-Raising, and H.S. Outreach, at end of 
the above session 
Presenters: Bonnie Spivey and Dan Voss 

 
Monday, 2-3:30 p.m. (Ballroom II) 

Title: “Indexing Progression” (WE 3A) 
Format: Progression 
Topic: “Does your Web Site Need an 
Index?” 
Presenter: Karen Lane 

 
Tuesday, 8:30-10:00 a.m. (Room 325) 

Title: “Index Evaluation Workshop” (WE 
5D) 
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Format: Progression 
Topic: One-on one index evaluation 
Presenter: Karen Lane 

 

Tuesday, 8:30-10:00 a.m. (Ballroom I) 
Title: “Willing and Able: How 
Technical Communicators with 
Disabilities Succeed in Their 
Profession” (UID 5U) 
Format: Progression (several tables and 
presenters) 
 
Topic: “Airport Security for People with 
Disabilities” 
Presenter: Mike Murray 
 
Topic: “Secondary Disabilities: The 
Vicious Circle (How One Impairment 
Can Cause Another)” 
Presenters: Ria Voss, Dan Voss, and 
Lori Gillen 

 
Tuesday, 11-12 Noon (Room 328) 

Title: “What Generation Gap? In 
Orlando, STC and UCF Are a Winning 
Combination!” (PD 6U) 
Format: Papers (presentation and 
demonstration) 
First Presentation: “ ‘Operation 
Butterfly’ and Other Adventures in 
Cooperation Between Industry and 
Academe: When Rip Van Winkle and 
Shirley Temple Join Forces, the Sky’s 

(Continued on page 2) 
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Orlando Chapter Members, continued 

(Continued from page 1) 
the Limit!” 
Presenters: Bonnie Spivey and Dan Voss 
 
Second Presentation:  “Meet Shanna the Cool and Dan the 
Nerd: A Behind-the-Scenes Peek at an Exciting STC Grant 
Project that Has Extended STC’s Educational Outreach to the 
High School Audience” 
Presenter: Dan Jones 

 
Tuesday, 2-3:30 p.m. (Room 336) 

Title: “Marketing Yourself” (PD7Q) 
Format: Panel Discussion 
Presenter: Christina Hammock 

 
Tuesday, 2-3:30 p.m. (Ballroom II) 

Title: “Section 508 for Dummies” (UID 7B) 
Format: Progression (several tables and presenters) 
Topic: “How Section 508 Improved my Work Environment” 
Presenter: Mike Murray  

 
Wednesday, 2-3:30 p.m. (Room 326) 

Title: “Using Humor to Diffuse Volatile Situations” (MG 11X) 
Format: Workshop 
Presenter: Dan Voss 

 
OTHER CONFERENCE ATTENDEES 
In addition to the eight Orlando presenters, the following nine 
members have also recognized the conference’s value and are 
planning to attend: Rose Benedicks, Alex Garcia, Robin Horn, 
Laurel Moll, Christina Payne, Rose Petralia, Jennifer Selix, Lisa 
Siegel, and Greg White. 
 
LEADERSHIP DAY PARTICIPANTS 
Special Leadership Day activities focus on subjects of interest to 
STC leaders at the chapter, SIG, and Society levels. According to 

the pre-conference program, “If you’re an STC leader, or 
if you’re interested in becoming one, consider attending 
these activities.” One of the things you’ll immediately 
notice in the following list of Leadership Day attendees is 
that all six of our student members will be taking part in 
these activities! They want to be the very best they can be 
in their profession, so they see themselves as leaders in 
their minds and “act as if” they are leaders – two proven 
techniques for achieving your goals. And if you’ve “been 
around for awhile,” just remember that “It is never too late 
to be what you might have been!” (George Eliot) 
 
The Orlando Chapter’s Leadership Day participants are 
Alicia Fellure, Alex Garcia, Robin Horn, Laurel Moll, 
Mike Murray, Rose Petralia, Jen Selix, Bonnie Spivey, 
Dan Voss, W.C. Wiese, and Greg White. (Story, page 6). 
 
Follow the leaders, folks! Start planning right now to 
attend the Annual Conference next year in Seattle, 
Washington!  MtMMtMMtM 

The theme of this year’s conference meshes with Baltimore’s 
legacy as a center of commerce and trade.  The event will be 
headquartered in the spectacular Hyatt Regency Hotel. 

Now available at our chapter meetings—the 
one-of-a-kind Orlando Chapter lapel pins. 

Only $500  Each 
Buy Buy Your Your Lapel Pin at the neLapel Pin at the next meetingxt meeting!! 

Help Support Orlando-STC. 
Click on the button to go to 

Amazon.com. Remember: A 
percentage of your purchase is 
rebated to the Orlando Chapter 
when you use our click-through. 

http://www.stc-orlando.org
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GLORIA JAFFE ON-HAND TO PRESENT  
In 2003, the Orlando Chapter established The Gloria Jaffe 
Outstanding Technical Communicator Award to honor the 
founder of the Orlando Chapter. Gloria Jaffe. She is an 
Associate Fellow of the Society and has mentored hundreds of 
technical communicators during her professorship at the 
University of Central Florida. The Chapter was honored to have 
Jaffe on-hand this year to present the Second Annual Gloria 
Jaffe Outstanding Technical Communicator Award on March 
24, 2004 at the Winter Park Civic Center. 
 
KELLI PHARO 
The 2004 Gloria Jaffe Outstanding 
Technical Communicator Award is 
being presented to Kelli Pharo. Kelli 
is a technical communicator who 
contributes to her employer, the 
community, and the Society. Kelli’s 
employer, PBS&J also received the 
company award for outstanding 
technical communication. 
 
Leadership: As an Orlando STC member, Kelli provides 
outreach regarding the profession. She promotes the profession 
and its virtues within the community and the corporation where 
she is employed. The judging team is impressed with Kelli's 
outreach to students, both as an employee mentor and STC 
mentor. Kelli attends chapter meetings, the annual conferences, 
and volunteers as the Assistant Editor for the STC Policies and 
Procedures SIG newsletter committee.  
 
Business: Kelli communicates within her organization and 
within the community the importance of her profession. Kelli 
completely revised the Aviation Services Department Standard 
Operating Procedures Manual and gained national recognition 
within the corporation where she works. Kelli created the style 
guide for PBS&J, and this documentation was published on the 
corporation’s website. Kelli is also responsible for QCAP 
(quality control and assurance for projects) at PBS&J, and the 
style guide is one way that she has contributed to quality 
technical communications. 
 
Kelli was selected to participate in a group at PBS&J that 
provided employee mentoring. During this mentorship, Kelli 
provided management with research about how technical 
communicators can provide benefits to the corporation. The 
Board of Directors is considering many of her ideas, including 
Kelli's suggestion that PBS&J create a technical documentation 
department. The judging team was impressed with Kelli’s 
ability to get the management to “listen” based on her input in 
other areas of the corporation.  
 
Education: Kelli completed her BA degree in English at UCF. 
Kelli mentors many students through community outreach 

Gloria Jaffe Awards Presented at March Chapter Meeting 
By Alicia Fellure, Jaffe Awards Manager 

projects and the STC - UCF mentoring program. 
 
AL LEBOEUF 
Al Leboeuf was recognized with the 
runner-up trophy for his technical 
expertise and contributions to his 
employer. 
 
Leadership: Al demonstrates work-
related leadership; he often “sees” 
opportunities to communicate 

information through advanced image capture techniques. 
Al is leader within the field of high-speed technical 
photography, videography, and cinematography. He is 
considered an imaging industry leader by many teams at 
Lockheed Martin and many of Lockheed’s government 
counterparts. 
 
Al is a member of the Society of Motion Picture and 
Television Engineers (SMPTE) for over 35 years, and he 
has provided leadership within this organization and the 
local Florida chapter. Al has been a chairperson for 
several SMPTE committees and helped in hosting two 
international conferences in Orlando.  
 
Business: Al is an extremely strong technical 
communicator within his company. He uses his 
specialized expertise to add value to information, and 
provides the Marketing and Engineering departments 
with critical video needed to support their business needs. 
Al finds off-the-shelf solutions to help engineers visually 
demonstrate proprietary and non-standard-imaging 
products. He guides the engineers in acquiring that 
imagery in a way that they can use it to communicate the 
product's quality. 
 
Al devises image capture strategies that support key 
communication objectives. Al provides a proactive 
approach in working with clients in the technical, 
management, and business development communities, as 
well as with editorial and graphic colleagues within the 
Communications Department. Al understands the 
combined power of words and pictures (still and moving) 
to inform and to persuade buyers and educate end-users. 
 
Education: Al graduated from the Rochester Institute of 
Technology with a BS in photography in 1967. Al has 
completed advanced electronics and motion picture 
schools while he worked in the U.S. Navy.  
 
SPECIAL THANK YOU TO THE JUDGES 
The 2004 judging team included Richard Phipps and 
Barbara Odom. 

(Continued on page 5) 
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UML, RDF, OMG, OWL, XML?  Do you know what these acronyms stand for?  Well, if you are like me and only know what 
one or two of these acronyms stand for, you had better join me on April 27 for our next meeting. 
 
“Instituting Single Sourcing” is our next meeting topic, and our very own Alan Gaynor will present it!  Alan is going to explain 
all of the acronyms associated with this new buzz phrase and provide us with the historical, present, and future impact of Single 
Sourcing. 
 
The “Instituting Single Sourcing” meeting topic ranked very high on our program survey.  You asked for it, and you got it!  Join 
us for an extremely informative evening.  MtMMtMMtM 

Chapter Meeting: 6:00 PM, April 27th, at the Winter Park Civic Center 
Single Sourcing: What’s All the Hype About? 
By Greg White, Chapter Vice President 

I’ve stood before attendees at our chapters on more than one 
occasion explaining the personal benefits of: 
•      Attending meetings and other chapter functions 
•      Participating in chapter activities 
•      Attending the annual conference 
•      Presenting at the annual 

conference 
 
Only by attending regulary, 
participating, and taking 
advantage of opportunities to 
learn and develop as a person 
and a leader will you realize the 
benefits of the full STC 
experience. 
 
STUDENTS GET IT! 
Not only will the Orlando chapter be represented by a large 
contingent of members (17) in Baltimore this year, but many 
of those members will be UCF students (7)! Most will be 
attending Leadership Day training sessions, and one will 
actually be presenting! Think of it, a young member, at her 
first-ever annual conference, and presenting to the 
international audience! 
 
IT WASN’T EASY. 
Anyone who has ever been a student knows the challenge of 
studying, working part-time to help pay the bills, and 
whatever else it takes to get that degree. As such, students 
normally don’t have a lot of discretionary income left for 
extras. Well, that didn’t deter our group, because they could 
see the importance of the annual conference, and they were 
determined to find a way to attend. 
 
Led by Bonnie Spivey, our group of future leaders 
approached the Student Government Association at UCF to 
obtain a portion of the activity fees that other organizations 
were enjoying. Because they were past the cut-off for 
submitting requests for the year’s budget, the group had to 

Student Leaders Prove They Are Tomorrow’s Chapter Leaders 
By Mike Murray, Chapter President 

work for several months with their senator, Brian Margolis. 
Once Senator Margolis had created a Bill in support of their 
request, the students had to attend several SGA meetings to 
convince the council to vote in favor of it. To pave the way 
for upcoming Future Technical Communicators club 

members, the group has already submitted a 
budget that includes funding for a conference 
in the 2004-2005 fiscal year. 
 
Eventually, the students were granted the 
funds to pay for two rooms at a conference 
hotel and six conference registrations. In 
spite of still being responsible for their own 
transportation and meals, the students will be 
in Baltimore meeting technical 
communicators from around the world and 
learning more than they could have ever 
imagined possible in a short period of time! 

 
THEY’RE THE CREAM OF THE CROP! 
The following students have taken control of their own 
destiny. They have the guts to make it happen! In addition, 
everyone will be attending Leadership Day sessions for STC 
leaders or those who are interested in becoming one. 
•      Alex Garcia 
•      Robin Horn 
•      Laurel Moll 
•      Rose Petralia 
•      Jennifer Selix 
•      Bonnie Spivey 
 
Bonnie is also presenting! 
 
Folks, our buttons are popping with pride over what you’ve 
accomplished. You are role models not only for UCF students 
and Orlando chapter STC members, but for students and 
members throughout the entire world of STC! Have a well-
deserved, wonderful time in Baltimore!  MtMMtMMtM 
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(Continued from page 3) 
Richard Phipps is the consulting services manager for CIBER, Inc., a global information technology consultancy. In his seven 
years with CIBER, he has served as a national recruiter, a regional recruiter, and as the recruiting manager for CIBER's Orlando 
area operation. Richard is a founding member of the Sanlando United Methodist Church’s Nehemiah Job Networking and 
Career Counseling Group, and he serves the Orlando STC as the chapter's employment manager. He has been a volunteer judge 
for the Orange County Science Fair, the Future Business Leaders of America's state and national competitions, and returns for 
his second year as a judge for the Gloria Jaffe Outstanding Technical Communicator Award, where he has served as a judge 
since the award’s inception. 
 
Barbara Odom is a Senior member of the Society and works as an independent contractor. She has served many Chapter offices, 
including manager of the Nominating Committee. Barbara is a Distinguished Chapter Service Award winner.  MtMMtMMtM 

Gloria Jaffe Awards, continued 

If you missed our last meeting you missed a major brain dump. 
The amount of information presented was amazing. Presenters 
manned seven tables to give us tips on a variety of topics.  
 
The night was also a night to recognize some outstanding 
technical communicators in our area. Karen Lane received the 
Distinguished Chapter Service Award. As the Society explains, 
"The Distinguished Chapter Service Awards acknowledge the 
work of chapter members who provide exemplary service to the 
Society through their dedication to the chapter and its activities."  
 
Dan Voss was recognized for recently receiving the 
Distinguished SIG Service Award for his work with the 
AccessAbility SIG.  
 
Our newest Associate Fellow, W. C. Wiese was recognized for 
his receiving this high honor, which will be presented to him at 
the annual conference in Baltimore.  
 
Alicia Fellure and Alan Gaynor were presented with their Senior 
member pins, which means they have completed five years of 
membership.  
 
Alicia Fellure, as Jaffe Awards competition manager, presented 
the Jaffe Award to Kelli Pharo, of PBS&J in Orlando. Al 
LeBoeuf, of Lockheed Martin Missiles & Fire Control, was 
runner-up.  
 
Gloria Jaffe attended the meeting to present the awards she 
inspired, and then anchored a progression table that discussed 
the origins of the chapter. We learned we owed much to Mrs. 
Jaffe being laid off by a local corporation and then being given 
the opportunity to launch the technical writing program at the 
University of Central Florida. She then set out to start a 
supporting STC chapter and hired Dr. Dan Jones away from 
Embry-Riddle.  
 
This was our chapter's seventh year for presenting the Melissa 
Pellegrin award to an outstanding student. Melanie Trickey 
received this award.  The chapter was honored to have Melissa's 

mother with us for the presentation of the award.  
 
The seven topics presented at this meeting were:  

• Resume and Cover Letters 
• Portfolios - Do's and Don'ts 
• Top Ten Job Segments Central Florida 
• Future of Staffing 
• Job Search Skills  
• History of the Orlando Chapter (with Gloria Jaffe) 
• What It Takes to Succeed (presented by the Jaffe 

winners).  
 
Unfortunately, we only had time to attend three of the 
sessions, so you had to pick which ones were the most 
appropriate for yourself. 
 
Some tips from Portfolios - Do's and Don'ts: You are hired 
from the interview,; the resume gets you that far. Keep both 
a hard and soft copy of your resume with you. Have a Table 
of Contents for your portfolio.  
 
Some tips from the Resume and Cover Letters: Tell the 
truth on your resume; you don't want to have to explain 
something later. Tailor your resume for each employer. Be 
prepared to discuss any claim you make.  
 
And from the Job Search Skills: Show your prospective 
employer something you have done for a previous employer 
to solve a problem for them. Use job agents to search for 
you. Use a free E-mail address such as HotMail for your 
resume. You can get to it from anywhere and if you change 
your ISP you can keep this address.  
 
Of course there were handouts and much more, but you 
really had to be there. Don't miss our next meeting on 
Tuesday, April 27, on Instituting Single Sourcing.  MtMMtMMtM 

If You Missed Our Last Meeting . . .  
By David Coverston, Chapter Secretary 
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Tool Tips: Using the Clipboard Toolbar 
By David Coverston, Chapter Secretary 

In all versions of the Office toolbar, an icon displays 
information about the source of the item on the clipboard, 
whether from a web page, another Word document, a graphic 
file, or a text file.  
 
To paste an item from the clipboard, click the clipboard icon 
for the text you want to paste. Word 2000 shows you the first 
line of the text in a yellow pop-up window when you place 
your mouse pointer over the icon. XP and 2003 display the text 
in the toolbar.  
 
To paste all the items you have at once, click the Paste All 
button on the toolbar. If you have a particular order you want 

your items to be pasted into 
your target document, make 
sure you collect the items in 
that order. To clear the 
items, click the Clear 
Clipboard button (2000) or 
the Clear All button (XP and 
2003). 
 
Office XP and 2003 both let 
you keep your last 24 items 
on your clipboard, whereas 

2000 limits you to 12. Office XP and 2003 have an additional 
feature that lets you delete individual clipboard items by right-
clicking their icon and choosing Delete.  
 
Unfortunately, none of the versions allow you to rearrange the 
paste order on the toolbar, so if you haven’t collected them in 
the right order, you will have to paste each item individually 
into your target document. 
 
If you have never used this toolbar before, try it the next time 
you have a lot of copying and pasting to do. The ability to copy 
formatted text from any office application into another, 
including Outlook in a very nice feature of the Office suite.  
MtMMtMMtM 

Occasionally I have to work on a document that requires 
extensive copying material from another document or set of 
documents, sometimes called a “cut and paste job.” 
Often the pieces I need to copy are not contiguous in a 
document, so I can’t select a section to copy and paste it. If 
I am using Word 2000 or later, I am in pretty good shape, 
because I can use the Office Clipboard toolbar to collect the 
pieces I need and paste them in as I need them. Office 97 
and earlier versions don’t have this toolbar, but there is a 
way you can collect and paste multiple items 
programmatically. If you are using a version that old, 
though, I would recommend that you consider purchasing a 
newer version. 
 
In Word 2000, display the Clipboard toolbar by choosing 
View > Toolbars > Clipboard from the menu bar. In Word 
XP, choose Edit > Office Clipboard from the menu bar. In 
Word 2003, you also view the Clipboard toolbar by 
choosing Edit > Office Clipboard from the menu bar.  
 
Actually, Word 20003 sticks the toolbar on a Task Pane, 
which is more like a task pain if you ask me. But the Paste 
options that it and XP automatically give you are nice, as 
you can see in the screenshot. 

The Office 2003 Clipboard toolbar. 

The Word 2000 Clipboard toolbar. 
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Society NewsSociety News  
****STC RECEIVES DIANA AWARD 
The Society for Technical Communication (STC) has been 
chosen as the 2004 recipient of the prestigious Diana Award 
given by the Association for Computing Machinery Special 
Interest Group on Computer Documentation (ACM SIGDOC). 
The ACM SIGDOC gives the Diana Award to organizations 
that have made an outstanding lifetime contribution to the field 
of user documentation.  
 
Criteria for the award include an organization's historical 
influence on the field of user documentation; its ongoing 
influence on academics and practitioners in the field; and its 
potential for future innovation. Past recipients of the Diana 
Award include MIT Press, the World Wide Web Consortium, 
and IBM. The Diana Award is named for Diana Patterson, past 
chair of ACM SIGDOC for three terms. (Please visit www.
acm.org/sigdoc/awards.html to see details.) 
 
"We're delighted to receive the Diana Award," says Peter 
Herbst, executive director of STC. "This is an honor for STC at 
every level--our board of directors, chapter leaders, 
membership, and everyone in the STC office." 
 
****STC ANNUAL SALARY SURVEY 
With its comprehensive breakdown of salary and benefit 

information for STC members in the United States and 
Canada, STC's Annual Salary Survey has provided a 
valuable resource for technical communicators since 1990. 
This year, we're asking all of our qualifying members* to 
participate--including those outside of the U.S. and Canada. 
We've made a few changes to make the survey easier to 
complete:  The survey is shorter,  its online, and its 
confidential!. 
 
This summer, look for the survey results in the Members 
Only section of our Web site. The deadline to return the 
survey is April 30, 2004, but why wait? Visit the survey Web 
page today at https://www.stc.org/salarysurvey/ss04-03.asp. 
 
*To qualify for the survey, you must be currently employed 
full-time as a technical communicator. You do not qualify if 
you are a consultant/independent contractor, unemployed, 
retired, or working fewer than 35 hours per week.  
 
****SCHOLARSHIP FOR HEARING IMPAIRED 
STUDENTS  
Applicants must be accepted as an entering or continuing, 
full-time undergraduate student at a college or university in 
the U.S. during the upcoming school year from the 
application period deadline. Deadline - May 1st. For more 
information visit: http://www.sertoma.org/General/
Scholarships.htm  MtMMtMMtM 

Three Winter Springs High School students captured awards 
in the Society for Technical Communication’s annual 
international high school technical writing competition, the 
STC Orlando Chapter has reported, continuing Central 
Florida’s strong history in the event. 
 
Topping the list was sophomore Andrew First, who won an 
Excellence Award and $500 for his essay “Artificial Muscles: 
Revolutionary Motors and Power Generators.”  Andrew’s 
brother Eric and Andrew Lai, both 11th graders, each earned 
Honorable Mentions for “CAPTCHA: Read This!” and 
“Telomerase: The Miracle Elixir for Cancer?”, respectively. 
 
In last year’s international competition, Eric First and Andrew 
Lai won Excellence and Merit awards to earn $500 and $300, 
respectively.  The two captured the first two places in this 
year’s STC Orlando Chapter’s 8th Annual Central Florida 
High School Technical Writing Competition, each winning 
Excellence Awards and $150, while Andrew First and 
sophomore Robyn Tapley each earned Merit Awards and $75. 
 
In addition, 10th grader Jennifer Lai, Andrew’s sister, was one 
of seven Achievement Award winners (earning $25 apiece) in 

the Central Florida 
competition—meaning that 
both families will be 
returning next year for what 
they hope will be a “three-
peat.” 
 
First place, and $1,000, in this year’s 
international competition went to a 
Houston high schooler, as it did last 
year.  Central Florida brought that 
home in 2001. 
 
Historically, Central Florida 
students have shown well in the 
international competition, 
including a 1-3-5 finish in 2001.  Over an 8-year period, they 
have earned 105 awards and $6,250 in cash prizes from STC 
for their writing prowess.   
 
A complete listing of the award winners, including the titles of 
their essays, is available at http://www.stc-orlando.org/
education/highsch/allhsawards.asp.  MtMMtMMtM 

Students Capture 3 of 6 Top Places  
High-School Students Win Awards in Int’l Technical Writing Competition 
By Dan Voss, Education Committee Manager 

http://www.stc-orlando.org/education/highsch/allhsawards.asp
http://www.acm.org/sigdoc/awards.html
https://www.stc.org/salarysurvey/ss04-03.asp
http://www.sertoma.org/General/Scholarships.htm
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Word Mint XV: The Bizarre World of Resistentialism 
Did Y’Ever Think Machines Were Out to GET You? Well, They Are . . . 
By Dan Voss 

Ultraresistentialistic (adj).  Of the firm and unalterable belief 
that inanimate objects possess the preternatural presience to 
recognize an opportunity to defeat the purpose of their human 
users via well-timed, self-actuating malfunctions, and, given 
such an opportunity, will invariably exercise it.  See also 
Murphy’s Law as it Pertains to Inanimate 
Objects.  From resistentialism (n), the theory 
that inanimate objects demonstrate hostile 
behavior against human beings.  
Resistentialism has been well documented 
through history.  The earliest known case was 
a cuneiform tablet in the shape of the 
Mesopotamian letter “I” that fell off a high 
ledge to knock unconscious a Babylonian scribe who was late 
for an audience with King Hammurabi, an event which led to 
the scribe’s subsequent execution (under the “I” for an “I” 
clause of the Hammurabic Code).  Modern-day examples 
include (1) the photo-copy machine which can sense tension 
in a user who is facing a critical deadline and is self-
programmed to jam at that time; (2) the stapler which will run 
out of staples precisely when the user has 15 seconds to staple 
a final handout and rush to a make-it, break-it business 
meeting, or, if it has been freshly reloaded with staples, will 
adjust by getting a staple caught in its throat and jam; (3) the 
chain saw which senses that a hurricane is coming, making it 
critical for the owner to take down a dead tree, and responds 
by having its chain slip off and become hopelessly tangled; 
(4) the automobile which knows to have a flat tire when the 
driver is rushing to a job interview for a position that carries a 
500% salary increase; (5) the pen that runs out of ink at a 
ceremonial contract signing attended by hundreds of 
dignitaries; and (6) the computer which can sense when the 
user has failed to save a critical file after working on it for 

several hours and will lock up 5 seconds before the job is 
complete and the user would remember to hit Save.  There 
are even cases, as yet unconfirmed, of collusional 
resistentialism among multiple inanimate objects (e.g., a 
reported case in a northeastern Iowa community college 

where the copy machine that jammed at a 
critical time appeared to actually 
communicate with a nearby work-group 
laser jet printer, which exhausted its toner 
cartridge at the very same moment, so as to 
thwart an attempted end-around by the 
human user the copy machine was 
attempting to defeat). This is just a 

representative sample; case histories abound.  Example, 
technical.  (1) When a piece of toast covered with peanut 
butter and grape jelly is dropped from a table which sits on 
a priceless Persian carpet, the laws of resistential physics 
overrule the standard laws of statistical probability; contrary 
to conventional probabilistic law, 100 times out of 100, the 
rotating piece of toast will land peanut butter-and-jelly side 
down, ruining the carpet.  Example, business.  (2) When 
Morris said, “We have all the data we need to win this 
contract right here in my laptop,” he triggered an immediate 
resistentialistic reaction which wiped out the hard drive of 
the laptop; the IT professionals never did isolate the cause 
of the failure, but we know.  Example, personal. (3) As 
Harry tried to sneak into the house late after going to 
Hooters with his bowling team, if he had understood 
resistential theory, he would have known his key was going 
to jam in the back door, awakening Martha and bringing 
down her unbridled wrath upon him—and he would have 
left a window open in the guest room to crawl through.   
MtMMtMMtM 

Melanie Trickey has received a $500 
undergraduate scholarship award from the 
Society for Technical Communication (STC) 
for excellence in technical communication. 
 
The scholarship, from the Melissa Pellegrin 
Memorial Scholarship Fund, was presented to 

the UCF senior at a meeting of the sponsoring STC Orlando 
Chapter at the Winter Park Civic Center on March 23. 
 
The scholarship fund honors the memory of a 1994 UCF 
graduate and Orlando STC chapter member. A plaque bearing 
the scholarship recipients’ names is on permanent display in 
the UCF English Department. 
 
A senior in the technical writing program at UCF with a 

perfect 4.0 GPA in her major, Melanie Trickey is a student 
member of the Orlando chapter of STC as well as a member 
of the chapter’s Education Committee.  She co-coordinated a 
successful STC fund-raiser earlier this year in support of the 
chapter’s educational outreach initiative to Central Florida 
high schools as well as to UCF. 
 
Melanie is also a member of UCF's technical writing club, 
Future Technical Communicators. 
 
After she graduates this spring, Melanie plans to “continue 
working as a technical writer and try to develop my skills and 
education. After a few years of working I plan on going back 
to school for my masters.”  MtMMtMMtM 

UCF Tech Writing Student Receives STC Pellegrin Scholarship 
By Dan Voss, Education Committee Manager 
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My article is written in response to the Ask Faye column, 
"Making the Transition from Student to Employee," in the 
December 2003 issue of STC's Intercom magazine. Ask Faye is 
an advice column for new technical communicators or anyone 
else who wants to learn more about our profession. 
 
A student asked Faye, "I will be graduating from a technical 
writing program soon. What should I be doing to get ready to 
leap into the job market?" 
 
I am writing this article because I am a graduate of Dr. Barry 
Maid's Multimedia Writing and Technical Communication 
(MWTC) program at Arizona State University. I graduated 
with my Bachelor of Science degree in May 2003. I am living 
proof that Faye's suggestions work. As soon as I began the 
program I was advised to start preparing for the job market, as 
you will see below. 
 
Legend: 
FA - Faye's advice                    SE - Sally's experience 
Faye suggested the following tips to upcoming graduates: 
 
INTERNSHIPS 
FA: Get an internship at the company you want to work for, or 
in the topic area you want to specialize in. 
 
SE: I began searching for an internship in May 2002, one year 
before I was going to graduate. Because the job market was so 
limited at the time, I was not picky about finding a company I 
wanted to work for or a specific topic area. I chose an 
internship from the ASU career website based on the fact that 
the job involved technical writing and it came with pay. I was 
also given the option of counting my internship as a course, so 
if you find one that is unpaid you should take it and understand 
that experience is more valuable than taking a class. Employers 
want to see real-world examples of work completed. 
 
In December 2002, five months before I graduated, I stood up 
at an STC meeting and announced I was looking to volunteer 
my time to gain experience in technical writing. Dr. Barry 
Maid nudged Sherry Michaels, the principal owner of Michaels 
& Associates, LLC, to take me upon my offer. I received the 
opportunity to volunteer 10 hours of my time per week to work 
on a project for Sherry's business and her consultants. The 
volunteering led me to working as a technical writer for her in 
April 2003 in a contract position. 
 
I worked part-time until mid-September, then went on a 
graduation trip to Prague. When I returned, I had a message 
from Sherry that she had another contract project for me to start 
the following Monday. I worked full-time for another four 
weeks on that project and later put in a fifth week on it. 
 
SOFTWARE FAMILIARITY 

Guest Article 
Transitioning From Student to Employee 
By Sally Landa, STC Phoenix Chapter Member 

FA: Employers typically require that you have both 
writing ability and the appropriate tool experience for the 
position. Know some of the most frequently used software 
packages, become an experienced user in at least one 
word processing program, and have working knowledge of 
a graphics program. 
 
SE: I took a junior college course in Web design, which 
taught me not only how to code HTML but also how to use 
a low-end editor (Arachnophilia). I thought I was taking 
the class for fun, but it ended up expanding my 
professional "tool belt." When I started my program at 
ASU, I had to create a Website in every core course. I was 
able to adapt and begin using Macromedia's 
Dreamweaver® HTML editor because it was more robust 
than the free editor I had been using. Because I knew 
HTML code, I could work in native HTML or in the 
WYSIWYG editor. 
 
The MWTC program at ASU does not support teaching 
tools. Either I already knew the software, or I learned it on 
my own while taking a course. The smartest choice I made 
academically was to take courses from the Graphics 
Information Technology (GIT) department as my 
electives. Sometimes technical writers are responsible for 
graphics, layout, and organization of a document in 
addition to text. In my GIT courses I learned visual 
communication and graphics while learning and using 
Adobe Illustrator®, Adobe Photoshop®, and 
QuarkXpress®. Taking GIT courses helped me add to my 
tool belt. The ability to use these programs also helped me 
to improve my skill at completing assignments for my 
technical writing course. Later, I also found out that 
learning QuarkXpress and the Adobe products made it 
easier for me to learn FrameMaker® and RoboHelp®. 
 
RESUME 
FA: Make sure your résumé is up to date and includes all 
writing jobs you've had, including volunteer positions. 
 
SE: You can format your résumé in several ways. As a 
student graduating with a new degree and looking for a 
career change, I emphasized my academics, courses taken 
as well as projects completed, and the software tools I 
knew. Then I listed my internships and volunteer projects 
along with all jobs ever held where I did some form of 
writing.  
 
To read the rest of this article, visit: http://stc-phoenix.
com/Rough%20Draft_Current/FebMar04_files/
student_febmar04.htm 

http://stc-phoenix.com/Rough%20Draft_Current/FebMar04_files/student.febmar04.htm
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YYYOUROUROUR O O OPINIONPINIONPINION C C COUNTSOUNTSOUNTS   
Thanks to everyone who filled out a meeting 

survey at the March meeting: “Technical 
Communication Employment Progression/ Portfolio and 
Resume Review.” Check out the results.  
 

"Topic Quality 
Excellent – 17 
Satisfactory – 0 
Not Satisfactory – 0 

 
"Comments: 
• “Mr. Dan Voss was amazing!” 
• “Excellent information. This event was truly helpful.” 
• “This was my first STC meeting and I enjoyed it 

thoroughly.” 
 
Remember to fill out a comment card at every chapter 
meeting you attend. We value and listen to your comments; 
they guide our efforts towards making each monthly program 
worthwhile.  MtMMtMMtM 

Once again, the Orlando 
Chapter STC has a lot to be 
proud of. We are practically 
busting at the seams with 

awards and accolades!  Good 
going and keep up the great work! 

 
Hopefully, many of you will be able to attend this 
year’s annual conference in Baltimore so you can 
brag about being part of one of the best chapters in 
the Society. If not, start planning now to attend next 
year’s conference, which is being held in the 
beautiful city of Seattle.  
 
As always, I welcome your feedback and opinions, so 
feel free to email me at ecoto72@yahoo.com. 
 
Thanks for reading, 
Erika 

FFFROMROMROM   THETHETHE E E EDITORDITORDITOR’’’SSS D D DESKESKESK   

         
Mark Your Calendars!Mark Your Calendars!Mark Your Calendars!   
   

   
"April 27th: Chapter Meeting - Single Sourcing 
"May 9 - 12th: STC 51st Annual International 

Conference in Baltimore, MD. 
"May 25th: Chapter Meeting 
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Contact Us 
 

President: Mike Murray 
Mike.Murray@lmco.com 
 

Vice President: Greg White 
Gwhite@tadpgs.com 

THE ORLANDO CHAPTER OF STC 
WELCOMES THE FOLLOWING NEW MEMBER! 

Rosalie Petralia (transfer from another chapter) 

"Speaker Quality 
Excellent – 17 
Satisfactory – 0 
Not Satisfactory – 0 

mailto: ecoto72@yahoo.com
http://www.stc-orlando.org
http://www.stc-orlando.org
mailto: ecoto72@yahoo.com
http://www.stc-orlando.org
mailto: mike.murray@lmco.com
mailto: gwhite@tadpgs.com

